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Genel - Yazihmlann Korunma Semasi

STANDALONE NETWORK
(Tek basina (Ag tizerinden
kullanim) kullanim)
v v v v
Roruna Kilidine Rilelomiy Koruna Kilidine | | Bilgisayarlara
Kilitlermis (Locked to Kilitlenmis Tocked & N
(Locked to key) computer) (Locked to key) computer)

Genelde programin korunmasi i¢in bir koruma kilidi (Hardlock, dongle) ve bu
kilit ile birlikte c¢alisan lisans dosyasi (password) kullanilir. Bazi Ozel
durumlarda ise koruma kilidi olmadan tek bir bilgisayarda veya ag (Network)
i¢cin lisans dosyasi verilerek kullanim sadlanir.

Programda kullanilan lisans dosyasinin ismi lservrc dir. Ileride
anlatilacadi lzere programin calisabilmesi ig¢in bu dosyanin program klasdriine
kopyalanmasi gerekir. Program kurulduktan sonra 30 glin lisanssiz ve koruma
kilitsiz calisir. Bu donemde vakit gecirilmeden Lisans dosyasi alinmalidir.

Lisans dosyasinin sadlanmasi ig¢in program paketiyle birlikte size
gétnderilen ILisans Isteme Formu ‘Request for License’nu doldurup 0049 6406 4745
e fakslamaniz gerekir. Bu form’u son sayfada bulabilirsiniz. Formun nasil
doldurulacagi kullanma sekline gbre ileriki sayfalarda anlatilmistir.

Eder programi Tek basina (Standalone) kullanacaksaniz sadece 2. sayfadaki
satirlari okuyunuz. Diger sayfalardaki bolimler ag kurulumu ig¢indir.

Programin siparisini verdiginizde bilgisayarinizda kullanacadiniz kilidin
Paralel (LPTl:) yazici ¢ikisinda mi yoksa USB ¢ikisinda mi kullanilacadina
karar verip bunu bildirmeniz uygun olur. Yeni Laptop’larda paralel baglanti
olup olmadidina dikkat ediniz. Yoksa, USB kilidine dedistirmek (sigortali)
yiksek yol masraflari nedeniyle istenmeyen bir durumdur.

Ag Uzerinde kullanmak Uzere aldiginiz lisans dosyasi ag disinda
kullanilamaz (&rnedin Laptop’ta) . Bu durumda ek lisans satin almak gerekir
veya bu lisansi ag’da dedil sadece tek basina (Standalone) kullanmak UGzere
lisans dosyasi istenir. Bu konuda basindan karar verilerek Network/Standalone
tercihi yapilir. Programi ¢ok sayida kisi ayni anda (gok lisansli) kullanacak
ise Network segenedi en uygunudur.

I1gili Literatiir:
Programlarin kurulusu ve problemlerin ¢ozimi igin programin kuruldudu
klasdrlerdeki ve ftp://ftp.csiberkeley.con/pubdocs/Installation instructions/
adresindeki :

License Trouble Shooting Guide - Standalone - CID key.doc (*)

License Trouble Shooting Guide - Network - CID key.doc (*)

License Trouble Shooting Guide - Standalone - Disk ID.doc (*)

License Trouble Shooting Guide - Network - Disk ID.doc (*)

Sap Install Instructions.pdf (*), SLM71sys.pdf, WImAdmin.doc,

Remote Conmuter Licensing.doc Kullanma kilavuzlarina da bakiniz.

(*) isaretli olanlar okumakta oldudunuz kullanma kilavuzunda derlenerek
cevrilmistir.
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SAP2000 v9'un ve Diger CSI Yazilmlannin
Tek Bilgisayarda (Standalone) Kurulumu

1- Lisans Isteme ‘Request for License’Formunun doldurulmasi:

Size gdnderilen pakette bulunan ‘Request for License formunda ilgili
bé&ltimleri doldururken sol altta ‘I already have a key’ (Program kilidim wvar)
bo1imint isaretleyip koruma kilidi UGizerindeki 4 karakterli (Alfanlmerik)
yazlyl buraya yaziniz.

‘Request for License’da ortada (Standalone/Network) seceneklerinden
(Standalone) u isaretleyiniz.

Sag altta, program isimlerinin yanina, satin almis oldudunuz lisans
sayisina (1) yaziniz. Ornek olarak SAP2000 v9 PLUS almis iseniz yanina (1)
yaziniz. Bu, bir adet lisans anlamina gelir. Ayni kilit ile dider yazilimlari
da kullanacak iseniz -Orne§in ETABS- onlarin yanina da (1) yaziniz.

Bu bilgileri 0049 6406 4745 (Computers & Engineering) e faks veya e-
mail ile (baser@comp-engineering.com) gdndererek lisans dosyasi isteyiniz. Bu
lisans dosyasinin adi lservrc dir ve saklanmalidir.

2- Koruma kilidi ile Programin STANDALONE Kurulumu:

Yazilimi ag’da (Network) dedil, tek bir bilgisayarda kullanacak
iseniz, CD ROM u slUrlclye yerlestirip Launch.exe yi ¢ift tiklayiniz. AJ’da
kullanacak iseniz bir sonraki sayfaya bakiniz.

Ekranda sadece STANDALONE segenedine tiklayip programi kurunuz.
LICENSE MANAGER i kurmayiniz. Program bundan sonra 30 glin lisanssiz ve
kilitsiz galisir.

Size gbnderilen (SA.zip) dosyasini (Winzip veya benzeri program
kullanarak) acip lservrc isimli dosya haline getiriniz. Bu dosyay1l programi
kurdugunuz &6rnedin (C:/Program Files/Computers and Structures/SAP2000 9/)
klasdriine (orada ayni isimle dosya bulunuyorsa lizerine) kopyalayiniz.

SAP2000 v9 yazilimini galistiriniz. Sorun olursa;
baser@comp-engineering.com a E-mail ile bildiriniz.

3- Koruma kilidi olmadan Programin STANDALONE Kurulumu:

Size gdnderilen pakette bulunan ‘Request for License’da ilgili
bélimleri doldururken sol alttaki U¢ segenekten ilki ‘Camputer’ (‘Programi
bilgisayara kilitleyerek kullaniyorum ve ek koruyucu kilidim yok’ anlaminda)
bolimint isaretleyip lisans dosyasi istemek Uzere bilgisayara ait &zellikleri
(Locking Code) bize bildirmek ig¢in su islemleri uygulayiniz:

(Program Files/Computers and Structures/SAP2000 9/echoid.exe) yi c¢ift
tiklayip calistiriniz. Ekranda beliren sayiyl Request for License’daki
(Locking Code) satirina yaziniz ve bu bilgileri 0049 6406 4745 (Computers &
Engineering) e fakslayip veya e-mail ile (baser@comp-engineering.com) lisans
dosyasi isteyiniz.

Size gbnderilen (SA.zip) dosyasini (Winzip veya benzeri program
kullanarak) acip lservrc isimli dosya haline getiriniz. Bu dosyayi programi
kurdugunuz &6rnedin (C:/Program Files/Computers and Structures/SAP2000 9/)
klasdriine (orada ayni isimle dosya bulunuyorsa lizerine) kopyalayiniz. Bu
dosyay1l ayrica saklayiniz. Program bu bilgisayarda her kurulusunda
kullanilacaktir. Diger bilgisayarlarda kullanilamaz.
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SAP2000 v9'un ve Diger CSI Yazihmlannin
Ag'da (Network) Kurulumu

1- Koruma kilidi ile Programin Ag’da Kullanimi ig¢in Lisans isteme
‘Request for License’Formunun doldurulmasai:

A iletisim protckolu TCP/IP (MS Windows) veya Netware IPX/SPX
(Novell) olmalidir. Programi AJ’da kurmak igin SERVER bulunmasi sart dedildir.
Uc uca baglanmis (Peer to peer) AJ’larda da bu islem gegerlidir. Program kilit
saglanmadan AJ’'da O6zel olarak gecici kullanim ig¢in kurulabilir. Bu islem icin
Para. 3’e bakiniz. Normalde daima kilit ile kullanilar.

Size gdnderilen pakette bulunan ‘Request for License’da ilgili
bélimleri doldururken sol altta ‘I already have a key’ (Programi kilitle
kullaniyorum) bdlUmint isaretleyip kilit lGzerindeki 4 karakterli (Alfantmerik)
yaziyl buraya yaziniz.

‘Request for License’da ortada (Standalone/Network) seceneklerinden
(Network) u isaretleyiniz. Bu form 25. Sayfaya eklemmistir.

Sag altta, program isimlerinin yanina, (aj Uzerinde kullanilacak) ve
satin alms oldujunuz lisans sayisini yaziniz. Ornek olarak SAP2000 v9 PLUS
yanina 3 yazili ise 3 lisans ayni anda (tek kilit ile) calistirilacak
demektir. Lisans sayisi bir (1) ise programi ag lzerinden farkli kisiler
(Workstation’lar) ayni anda kullanamaz fakat farkli zamanlarda calistirabilir.
Buna karsilik, bu lisans ad disinda kullanilamaz (&rmedin Laptop’ta). Bu
durumda ek lisans satin almak gerekir veya bu lisansi ad’da dedil tek basina
ve sadece (Standalone) kullanmak lzere lisans dosyasi istenir. Bu konuda
basindan karar verilmelidir.

Bu bilgileri 0049 6406 4745 (Computers & Engineering) e faks veya e-
mail ile (baser@comp-engineering.com) gdndererek lisans dosyasi isteyiniz. Bu
lisans dosyasinin adi lservrc dir ve saklanmalidir.

2a - Koruma kilidi ile Programin Ag’da (Network) Kurulumu
ilk adimlar:

AJ'da (Network) Server bulunuyorsa orada, yoksa sadece u¢ uca baglanmis
olan ag’da (peer to peer) bir bilgisayara server gdrevi vererek baslanir. Bu
bilgisayara SERVER diyelim. Bu yazilimi bu ad’a ilk kez kurdudumuzu
farzedelim.

Once SERVER’de SAP2000 v9 yazilim CD sinden SERVER versiyonunu kurunuz.

Devam ederek LICENSE MANAGER yazilimini da ayni CD den kurunuz.

Bu sayfanin basinda anlatilan lisans dosyasi alinincaya kadar programin
kullanilmasi i¢in 30 ginlik kullanma hakki sadlanmistir. Bundan yararlanip 30
glnlik programin kurulmasi igin: (Program Files/Computers and Structures
/SAP2000 9 Server/License Manager/lsLicense.bat) dosyasini cift tiklayarak
galistiriniz. Su anda koruma kilidini bilgisayara takmaniz gerekmez.

2a-1 - $imdi SERVER ile isimiz bitmistir. AJ lzerinde SAP2000 v9 un
kullanilacagi diger bilgisayarlardan birincisine (Workstation 1 diyelim)
gecip su islemleri yapiniz:

Workstation 1 de ag lUzerinden SERVER olarak secilen bilgisayara ulasarak
dizin ismi: (Program Files/Computers and Structures/SAP2000 9 Server/Setup.exe)
dosyasini ¢ift tiklayip galistiriniz.

Boylece bulundugunuz bilgiyara (Workstation 1) SAP2000 v9 yazilimini
SERVER’den kurmus ve iletisimi saglamis olursunuz.

Workstation 1 de iken SAP2000 v9 u ¢alistiriniz. Lisans dosyasi almadan
30 giin ¢alistigini kontrol etmek icin: Ust Meniide (Help > About SAP2000)in alt
satirinda ‘30 gin kaldi’ notunun bulundugunu kontrol ediniz.

(2a-1) de tanimlanan bu islemi Workstation 2, 3 ... ic¢in de
tekrarlayiniz.
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2b - Koruma kilidi ile Programin Ag’da (Network) Kurulumu
Génderilen Lisans Dosyasi’nin Ag’a uygulanmasi:

Koruma Kilidini (Hardlock, Dongle) bilgisayara takiniz. Size
gbnderilen (NET.zip) dosyasini (Winzip veya benzeri program kullanarak) ac¢ip
lservrc isimli dosya haline getiriniz. Bu dosyayi (Program Files/Computers and
Structures/SAP2000 9 Server/License Manager) klasdrine kopyalayiniz ve;
(lsLicense.bat) 1 c¢ift tiklayiniz. BOylece Lisans (password) kaydedilmis olur.

Eger daha &nce dider yazilimlar nedeniyle takilmis kilitler varsa,
SAP2000 v9 kilidi en son olarak takilmalidir.

Diger bilgisayarlarda (Workstation) lisans dosyasi ile ilgili bir
islem yapilmaz, fakat (Help > About SAP2000) Menlsinden Lisans ig¢in ka¢ gin
kaldigina bakarak kurma isleninin basarili olup olmadidi kontrol edilebilir.
(Simdi 30 glinden farkli bir gin sayisi ile yenilenmis olmalidir) .

3 - Koruma kilidi olmadan Programin Ag’da Kullanimi:

Adim (2a) ve (2a-1) deki ‘Ilk Adimlar’ 1 ayni sekilde uygulayiniz.

Bu yazilimi bu ag’a ilk kez kurdugumuzu farzedelim.
Size gbnderilen pakette bulunan ‘Request for License’da ilgili bdlimleri
doldururken sol altta ‘Computer’ (‘Programi bilgisayara kilitleyerek
kullaniyorum ve ek koruyucu kilidim yok’ anlaminda) bdlimint isaretleyip
lisans dosyasi istemek Uzere bilgisayara ait 6zellikleri (Locking Code) bize
bildirmek igin su islemleri uygulayiniz:

(Program Files/Computers and Structures/SAP2000 9 Server/echoid.exe)
yi Server Bilgisayarinda (License Server Computer) ¢ift tiklayip ¢alistiriniz.
Ekranda beliren sayiyi Request for License’daki (Locking Code) satirina
yaziniz ve bu bilgileri 0049 6406 4745 (Computers & Engineering) e faks veya
e-mail ile (baser@comp-engineering.com) géndererek lisans dosyasi isteyiniz.
Bu lisans dosyasinin adi lservrc dir ve saklammalidir.

Size gdnderilen (NET.zip) dosyasini (Winzip veya benzeri program
kullanarak) acip lservrc isimli dosya haline getiriniz. Bu dosyayi (Program
Files/Computers and Structures/SAP2000 9 Server/License Manager) klasOrlne
kopyalayiniz ve (lsLicense.bat) 1 ¢ift tiklayiniz. Bbylece Lisans (password)
A§'a kaydedilmis olur.
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LISANS KONTROLU ve KURMA PROBLEMLERININ COZUMU
LICENSE TROUBLE SHOOTING

Koruma Kilit’li ve Tek Kullanicili Problemlerin COzumii:
(License Trouble Shooting Guide - Standalone - CID key.doc)

Birinci Adim - Lisans Sifresi Kontrolii:

Program klasdrindeki (lsdecode.exe) yi calistiriniz. Sekildeki DOS ekranina benzer
bir gbrintl belirecektir.

~| C:\Program FilesVComputers and Structures\ETABS 8 Plusilsdecode.exe

SentinellM 7.2.8 Licenze Decoding Utility
Copyright <C» 2082 Rainhow Technologies, Inc.

Reading licensze codez from file: "C:i:sProgram Files“Computers and Structuresz“ETAB
% 8 Plus~lservrc"

License code: "“"P?36CHZR6QEQYZPUUGHZG?RTKIHB4UDCEEHUAI IMDJPUZKJER “EtabHL" versio
n "8". expires Midnight of Aug 31. 2865, additive"

Mormal Standalone
"EtabHL"
Ilsll

1

Unlimited.

Morning of Aug 11. 26863
Midnight of Aug 31, 268685
"2806B3"

Sentinel Computer ID

License Type
Feature name
Feature version

Max concurrent users
Soft limit on users
Licensze start date
Expiration date

Client #1 locking code
Lock code depends on

Additive license <numher of tokens will be added>.

Allowed, hold time set by license.
1860 secs €3 mind<s>>
Mo action.

Additivesexclusive

Held licenses

Token lifetime {(heartheat)
Action on clock tamper

Press Enter to continue .

(License Type : Normal Standalone) olarak gdriUmmelidir. (Trial Standalone) olarak
gorintiyorsa program kurulmamis ve siz hala 30 ginlik lisans stresini
kullaniyorsunuz demektir. Bu durumda baser@comp-engineering.com veya Tel: 0049
6406 73667 ye bildiriniz.

Tkinci olarak programin son kullanma tarihini (Expiration date) kontrol ediniz.
Uclinctl olarak kullanicinin lisans sifresini (Client #1 locking code) not ediniz.

Bu, ilerideki adimlarda kilit sifresiyle karsilastirmak ig¢in gerekecektir.
Ayrica (Lock code depends on) ic¢in ‘Sentinel Computer ID’ yazdidini goriniz.
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Tkinci Adim - Kilit Sifresi Kontrolii:

Program Lisans Dosyasinin (Password) Koruma Kilidi ile iletisimde olup olmadigini
kontrol igin kilidi (Paralel veya USB) bilgisayara takiniz.

Program klasdrindeki (WechoID.exe) yi calistiriniz. Sekildeki Windows ekranina
benzer bir gbrintl belirecektir.

m SentinelLM Host Information Utility

Locking Criteria
¥ IP Address |10.0.0.105
[~ IDFPROM |
¥ DiskID | 0272309489
¥ Host Hame | FAISALXP]
v FEthernet Address | 00-02-B3-A4-EZ-BE
[ Hetware [P |
[T Hetware Serial |

(T compmrin_—"iogrzm s natte o commntente

[ Custom or USE key)
[ ProcessorID |

Locking Diata

Selector Ozl E Code 07744

EJer (Computer ID) kutusu gri dedil de aktif ise, Program/Bilgisayar koruma
kilidini tanimis demektir. Bu durumda bundan sonraki satirlari okumadan bir sonraki
sayfadaki Ugiincli Adim a geginiz.

EJer (Computer ID) kutusu gri olarak kalmis ve aktif dedilse Program/Bilgisayar
koruma kilidini tanimamis demektir. Su islemleri uygulayarak devam ediniz:

Program kurulduktan sonra kilit slUrliclsti otomatik olarak bilgisayara kurulur ve
devamli aktiftir. En son kilit sUrlGclsini kullandidinizdan emin olmak ig¢in su
adresten indiriniz.

ftp://ftp.csiberkeley. com/pubdocs/KeyDriver/

Buradan SSD5411-32bit.exe dosyasinil bos bir klasére kaydediniz. Herhangi bir USB
kilit bilgisayarinizda takili ise ¢ikartiniz. Bu dosyay1i ¢ift tiklayiniz ve kurma
islemini bitiriniz.

Bilgisayarinizi kapatip aginiz (reboot) .

E§er USB kilidiniz varsa tekrar bilgisayariniza takiniz.

SAP2000 v1l igin su adimlari uygulayiniz:

- Usb kiltleri g¢ikariniz.

- Programi kurdudunuz klasdrdeki /Keydriver altklasdrinde

Computers and Structures/SAP2000vl1l/Keydriver/setup.exe

Programini g¢alistiriniz.

- Bilgisayari kapatiniz (reboot), USB-kilitleri takiniz ve bilgisayari
aginiz.

(WechoID.exe) dosyasini ¢ift tiklayarak tekrar galistiriniz. (Computer ID) kutusu
hala gri degil, aktif ise Uglincli Adim a geciniz.
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(Computer ID) kutusu hala gri ise su islemlerle devam ediniz:

ftp://ftp.csiberkeley.com/pubdocs/KeyDriver/ adresinden indirecediniz
(SetupSysDriver.exe) dosyasini ¢ift tiklayarak calistiriniz.

Sentinel System Driver 10 x|

File Tools VYew Help

Add/R epair B emovwe installation |

‘ﬁ Rainbow Technologies
: H.’ Sentinel System Driver
I S Configuration Liility

Stop HT parallel diiver

Inskalled diver werzion
’7 Verzion 547 for YWindows NT /2000 detected.

Ready P

| Configure Driver | kutusunu tiklayarak ekrani izleyiniz.

Eger bilgisayarda paralel yazici ¢ikisi varsa su gdrintl ekrana gelir ve paralel
¢ikis (port) hatali olarak ayarlanmis demektir. Su islemlerle devam ediniz:

x|
Ports
Phwsical Addr Dos Created
Addresz  Port Type Bus # Buz Type Space Addr  Use? By

Add Remove | Edit | oK | Cancel Help About

kutusunu tiklayiniz. Su ekran gdrintilenir:

e
Use this port? i* Yes i~ Ho
Bus Address:
Bus Mumber: Bus 0 LI
Bus Type: ISA LI ﬂl
Addrezs Space: 140 ;I Help |
Port Type |IBM AT =1

Autodetect Used?

1

Port Ownership Method:
¥ Auto I Spstem I Raise Priority

Acquisition Timeout [ms): 10000
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Burada | Buss Address: | kutusuna 378 yaziniz.

Kutusunu tiklayiniz ve su ikaz gdrlUnir:

Sentinel Driver x|

& You are about ko change the settings of this part, Chick 'OK' to continue, '"Cancel’ to go back.,

Cancel |

Kutusunu tiklayiniz ekranda kullanicinin UGrettidi 378 adresli c¢ikis (IBM AT
port) gbsterilmektedir.

Sentinel Driver . : b

Phusical Addr DOs Created
Address  Port Type Bus # Bus Type Space Addr  Use? By

378 IBM AT

Add HBemove Edit DK Cancel Help About

Kutusunu tiklayarak diyalog penceresini kapatiniz.

Simdi (WechoID.exe) dosyasini c¢alistirdidimizda (Computer ID) kutusu gri dedil
(beyaz) aktif olmasi gerekir.
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Uclincli Adim - Son Kontrol:

(Computer ID) kutusu disinda tim kutulari tiklayarak isaretlerini kaldiriniz.

m SentinellLM Host Information Utility

Locking Criteria

[~ IP Address | 10.0.0.105

[~ IDFROM |

[~ DiskID | 1272309439

[~ HostName | FAISALXP]

[ Fthernet Address |UU—D2-E3-ﬁﬂ-E2-EIE

[ Hetware IPE |

[ Metware Serial |

v Computer ID |?EEIIEQE

[ Custom |

[ Processzor[D |

Locking Data

Selector | DxE0 [Cnde |D:-.'2EIr5EIE }
)4

Pencerenin altindaki (Code) yazisinin yaninda bulunan kutudaki alfanimerik sayinin
en basta -Birinci Adim- daki (lsdecode.exe) dosyasini c¢alistirarak buldudumuz
(Client #1) sayisi ile ayni oldudunu kontrol ediniz. EJer bu degerler farkli ise e-
mail ile (baser@comp-engineering.com) e bildiriniz. Bu mail’de (lsdecode.exe) ve
(WechoID.exe) sonuglarinin ekranlarinin kopyalanmis grafik dosyalarini da birlikte
gbnderiniz. Bundan &nce son olarak su kontrolu da yapiniz:

The program does not recognize the key. What is your operating system including
service pack? You can also download and install the latest Sentinel Protection Installer
(key Driver) for the key at the following web site:
ftp://ftp.csiberkeley.com/pubdocs/SentinelProtectioninstaller7.1.0/

Download the file Sentinel Protection Installer 7.1.0.ZIP' to a temporary (empty) folder,
extract the files, and then double-click on setup.exe to execute it. This is a one-time
installation. You should not need to perform the installation again unless you uninstall it.
If you get no error messages, re-boot your machine. The setup is now complete.



CSI Programlari Kurulmasi, Kullanilmasi ve Sorunlarin Cozimii - Eyliil 2005 - Sayfa 10

Lisans Kontrolu ve Kurma Problemlerinin Coziumi -
Koruma Kilit’siz ve Tek Kullanicili Problemlerin Cozumi
(License Trouble Shooting Guide - Standalone - Disk ID.doc)

Birinci Adim - Lisans Sifresi Kontrolii:

Program klasdrindeki (lsdecode.exe) yi calistiriniz. Sekildeki DOS ekranina benzer
bir gorintl belirecektir.

C:\Program Files\Computers and Structures\SAP2000 8 Nonlinear\lsdecode.exe

SentinellM 7.2_.8 License Decoding Utility
Copyright (C> 2802 Rainbow Technologies, Inc.

Reading license codes from file: "C:“\Program Files“Computers and Structuresz“SAP2
BAA 8 Monlinearslservrc"

License code: "2C7BABSZHCJIFDGYFJILOKZASSHCDFGYMERUZ 76 7YHJJGTH?SH “SAPHLY version
8", expires Midnight of Hov 38, 2885, additive"

Mormal Standalone
SAPNL”

1

Unlimited.

Morning of Hov 14, 268683
Midnight of HNov 3@, 2885
VZLBEL"

Disk ID in hexadecimal

License Type
Feature name
Feature version

Max concurrent useps
Soft limit on users
License start date
Expiration date

Client #1 locking code
Lock code depends on

Additive license (number of tokenz will bhe added>.
Allowed,. hold time set hy license.

188 secs <3 minds))

Mo action.

Additivesexclusive

Held licenses

Token lifetime t{heartbeat?)
fAiction on clock tamper

Press Enter to continue .

(License Type : Normal Standalone) olarak gdriUmmelidir. (Trial Standalone) olarak
gérintyorsa program kurulmamis ve siz hala 30 ginlik lisans stresini
kullaniyorsunuz demektir. Bu durumda baser@comp-engineering.com veya Tel: 0049
6406 73667 ye bildiriniz.

Ikinci olarak programin son kullanma tarihini (Expiration date) kontrol ediniz.
Uclinctl olarak kullanicinin lisans sifresini (Client #1 locking code) not ediniz.
Bu, ilerideki adimlarda Bilgisayar Sifresiyle (Disk ID) karsilastirmak igin

gerekecektir.

Ayrica (Lock code depends on) ig¢in ‘Disk ID in Hexadecimal’ yazdidini gdriniz.
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Bilgisayar Sifresi’nin (Disc ID) Kontrolu:

Bilgisayar Sifresini (Disk ID) kontrol ig¢in (WechoID.exe) yi calistiriniz.
Sekildeki Windows ekranina benzer bir gdrintl belirecektir.

m SentinellM Host Information Utility

Locking Critetia
[ IP Address | 169254 56.128
[~ IDFPROM |
[ W DiskID | 1xBABEA391 ]
I Host Mame |HR‘HHI&.‘I
[~ Fthernet Address I 00-0C-T6-0D-24-T4
I Hetwrare [PX |
[T Metware Serial I
I Computer ID |
[ Custom I
[” ProcessorlD |
Locking Diata
Selector | Uxd [ Code |Dﬂ53E1 ]
(]

(Disc ID) kutusu disinda tim kutulari tiklayarak isaretlerini kaldiriniz.

Pencerenin altindaki (Code) yazisinin yaninda bulunan kutudaki alfantmerik sayinin
en basta -Birinci Adim- daki (lsdecode.exe) dosyasini c¢alistirarak buldudumuz
(Client #1) sayisi ile ayni oldudunu kontrol ediniz. EJer bu degerler farkli ise e-
mail ile (baser@comp-engineering.com) e bildiriniz. Bu mail’de (lsdecode.exe) ve
(WechoID.exe) sonuglarinin ekranlarinin kopyalanmis grafik dosyalarini da birlikte
gbnderiniz.
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Lisans Kontrolu ve Kurma Problemlerinin Coziimii —
Koruma Kilit’li ve Ag’da Kullanildiginda Problemlerin COziimil

(License Trouble Shooting Guide - Network - CID key.doc)

Once su konulari asadida gdsterildigi gibi kontrol ediniz:
Birinci Adim: (SentinellM License Server) programi kurulmus ve g¢alisiyor
olmalidir
ikinci Adim: Bilgisayariniz koruma kilidini taniyabilmelidir

Uglincli Adim: SERVER (License Server) CSI yazilim lisansini (License Code)
tanimalidair

DOrdiincii Adim: Workstation’lar lisans kodunu (password) SERVER’den
alabilmelidir.

Birinci Adim -
(SentinellM License Server) programi kurulmus ve calisiyor olmalidir

Kurulmus mu?

SentinellM programi kurulmus ise (Control Panel) de (Add/Remove Programs) da
program ile ilgili bir kayit bulunmalidir. Yok ise bu ddékimandaki A§’da (Network)
Kurulumu bSlimine veya programla gelen CD ROM daki Sap Install Instructions.pdf ye
bakiniz.

Calisiyor mu?

SentinellM programi normalde otomatik olarak g¢alisir. (Control Panel) > (Services)
Burada SentinellM kaydinin bulunduduna emin olun. Bulduktan sonra durum’a (status)
bakip calismakta olduduna emin olun (started). EJer calismiyorsa sagd tiklayarak
(start) ile calistiriniz.

SERVER ile iletisim tamam mi?
(Program Files/Computers and Structures/SAP2000 9 Server/WImAdmin.exe) programini
¢ift tiklayarak c¢alistiriniz.

Eder ‘SentinelIM: Error[17] Probably no servers running on this subnet’ mesajini
alirsaniz sizin Firewall’iniz iletisimi engelliyor olabilir. SERVER ve CLIENT
arasinda iletisimin olabilmesi ig¢in UDP port 5093 ac¢ik olmalidir. Bunun ig¢in teshis
programi olan UDPTester su adresten indirilebilir:

ftp://ftp.csiberkeley.com/pubdocs/KeyDriver/
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ikinci Adaim:
Bilgisayariniz koruma kilidi taniyabilmelidir

Program Lisans Dosyasinin (Password) Koruma Kilidi ile iletisimde olup olmadidini
kontrol igin kilidi (Paralel veya USB) bilgisayara takiniz.

Program klasdrindeki (WechoID.exe) yi calistiriniz. Sekildeki Windows ekranina
benzer bir gbrintli belirecektir.

Eﬂ SentinellL M Host Information Ltility

Locking Criteria
W IF Address | 10.0.0.105
[ 1D PROM |
WV DiskID | 072309 489
v Host Hame | FAISALZPI1
[ Ethernet Address | 00-02-B3-4 4 E2 BE
[T Hetware IPE |
[ HMetware Jerial |
(7 compuerio_J—raaram s ynatie o commaniente

[T Custom Dlr USE key)

[ ProcessorID |

Locking Data

Selector Oxz1E Code Dx77Fac4

EJer (Computer ID) kutusu gri dedil de aktif ise Program/Bilgisayar koruma kilidini
tanimis demektir. Bu durumda bundan sonraki satirlari okumadan bir sonraki
sayfadaki Ugiincli Adim a geginiz.

EJer (Computer ID) kutusu gri olarak kalmis ve aktif dedilse Program/Bilgisayar
koruma kilidini tanimamis demektir. Su islemleri uygulayarak devam ediniz:

Program kurulduktan sonra kilit slUrliclsti otomatik olarak bilgisayara kurulur ve
devamli aktiftir. En son kilit sUrlGclsini kullandidinizdan emin olmak ig¢in su
adresten indiriniz.

ftp://ftp.csiberkeley. com/pubdocs/KeyDriver/

Buradan SSD5411-32bit.exe dosyasini bos bir klasére kaydediniz. Herhangi bir USB
kilit bilgisayarinizda takili ise ¢ikartiniz. Bu dosyay1i ¢ift tiklayiniz ve kurma
islemini bitiriniz.

Bilgisayarinizi kapatip aginiz (reboot) .
Eger USB kilidiniz varsa tekrar bilgisayariniza takiniz.

SAP2000 v1l igin su adimlari uygulayiniz:

- Usb kiltleri g¢ikariniz.

- Programi kurdudunuz klasdrdeki /Keydriver altklasdrinde

Computers and Structures/SAP2000vl1l/Keydriver/setup.exe

Programini ¢alistiriniz.

- Bilgisayari kapatiniz (reboot), USB-kilitleri takiniz ve bilgisayar:i
aginiz.
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(WechoID.exe) dosyasini ¢ift tiklayarak tekrar galistiriniz. (Computer ID) kutusu
hala gri degil, aktif ise Uclincli Adim a geciniz.

(Computer ID) kutusu hala gri ise su islemlerle devam ediniz:

ftp://ftp.csiberkeley.com/pubdocs/KeyDriver/ adresinden indirecediniz
(SetupSysDriver.exe) dosyasini ¢ift tiklayarak calistiriniz.

Sentinel System Driver O] =]

File Toaols Yew Help

Add/R eparsRemowve inztallation I

‘ﬂ Rainbow Technologies

; \.’ Sentinel System Driver
I S=% Configuration Utility

Stop HT parallel driver

Wersion B 47 For Windows NT /2000 detected.

" Installed diver wersion

Ready e

| Configure Driver | kutusunu tiklayarak ekrani izleyiniz.

Eder bilgisayarda paralel yazici ¢ikisi varsa su gorintll ekrana gelir ve paralel
¢ikis (port) hatali olarak ayarlanmis demektir. Su islemlerle devam ediniz:

Sentinel Driver x|
Ports
Phusical Addr Dos Created
Address  Port Type Bus # Bus Type Space Addr  Use? By

Add | Bemove | Edit | OK Cancel Help About

kutusunu tiklayiniz. Su ekran gdrintilenir:

Burada | Buss Address: | kutusuna 378 yaziniz.

X

Usze this port? * Yes T Ho
Bus Address:
Bus Mumber: Bus 0 LI
Bus Type: IS4 LI ﬂl
Address Space: 170 LI Help I
Port Type |||“| AT ;I|
Autodetect Used? I
Port Ownership Method:

¥ Auto [~ Spstem I” Raise Priority

Acquisition Timeout [ms): |10000
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Kutusunu tiklayiniz ve su ikaz gdrinir:

& ou are about o change the settings of this port, Chick '"OK' to continue, "Cancel' to go back.

Cancel |

Kutusunu tiklayiniz ekranda kullanicinin UGrettidi 378 adresli c¢ikis (IBM AT
port) gbsterilmektedir.

Sentinel Driver = b

Phusical Addr DOs Created
Address  Port Type Bus # Bus Type Space Addr  Use? By

Add HBemove Edit DK Cancel Help About

Kutusunu tiklayarak diyalog penceresini kapatiniz.

Simdi (WechoID.exe) dosyasini ¢alistirdiimizda (Computer ID) kutusu gri degil
(beyaz) aktif olmasi gerekir. (Computer ID) kutusu disinda tUm kutulari tiklayarak
temizleyiniz. Pencerenin altindaki (Code) yazisinin yaninda bulunan kutudaki
alfantmerik sayisini (Server sifresini) not ediniz. Bu, ilerideki adimlarda Lisans
dosyasi (License code, password) sifresiyle karsilastirmak ic¢in gerekecektir.

m Sentinelld Host Information Utility

Locking Criteria
T IP Address | 10.0.0.105
™ IDFROM |
[~ DiskID | D7 2300 AE0
[~ HostName | FAISALXPI
[ Ethernet &Address | 00-02-B3-44-E2-BE
[ Hetware IPX |
[ Metware Serial |
W Computer ID | 72E11208
[T Custom |
[ ProcessorID |
Locking Data
Selector |0xE0 ‘ Code | D:x206B3
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Uciincli Adam:
SERVER (License Server) CSI yazilim lisansini (License Code) tanimalidir

(Program Files/Computers and Structures/SAP2000 9 Server/WImAdmin.exe) programini
¢ift tiklayarak c¢alistiriniz.

(Subnet Servers) ve (Server) klasdrlerini tiklayarak aginiz (genisletiniz).
Programinizin lisansini burada géreceksiniz.

m WimAdmin
File Edit View Help
[#-gm Defined Servers ~
25 Subnet Servers Server information
igbalzk1.csi-ad. computersandstructures Server name: |2k1.Csi-ad.computersandstructun IP address: 10.0.0.109
= ighalxplap.csi-ad. computersandstructur
P Erahb &
==} marilvnzkl .csi-ad.computersandstruckur Feature information
* o Feature name: | EtabPL Werzion: g
+ [ csIcol 8
+-[] EtabhL & Statistics : : :
+- ™ EtabNLC & I use: Total Queued:
+- ™ EtabrL & Total uzers: [HNHINENNENNNREEEN| 1 1 0
#-[T] Safe 7 Reserved: 0 0
+ - SaferL 5
[ sar s Comrmuter: 0 0
+- [ sapaD &
+-] saPER 5
- E SAPHT 8 Redundant: | MWa Mumber of zervers: 1
[T SAPML &
<[ s4P0S & Detailed information
+ [ sappL 5 Licenze Irnfo ] Cliert |nf.;,]
[ B8
- @ MARILYMMTZ [ Licensze tupe: Nnrrﬁal Iicense] Start date; | Wed .&UQDE DDDDDD 2003
+- [ cs1col 8 e —
¥ E SEA Momeammterlicetis: Yes End date: | WedAug 31 23:53:53 2005
Criteria | Yalue | ”~
Haolding criteria Wendor specified
K.ey litetime 180 secs
Log encryption level 1
b ajority ke Mo
Murbaroksubat 0
Server #1 locking code...  BO0-Z7ATE j
Sharing criteria Client hostname D
Sharing lirnit 3 e
£ 2 - o
Ready LI

Lisans orada ise daha da agarak ‘Lisans Tipi’ ne bakiniz. Burada ‘Trial License’
dedil ‘Normal License’ yazmalidir. (Server #1 locking code) daha &énce ikinci adimda
WechoID.exe yi ¢alistirarak buldujunuz sayiya esit olmalidir. Ayrica lisansin
gecerlilik tarihini kontrol ediniz.

Burada dodru veriler gdérinse bile size gdnderilen lisans dosyasi bozuk ise veya
herhangi bir nedenle bozulmussa lisans islemi tamamlanmis olmayabilir. Bu nedenle
su islemle kontrola devam etmelidir:
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(Program Files/Computers and Structures/CSI Program Server (Ormedin- SAP2000 9
Server) /License Manager/ lsdecode.exe) yazilimini calistiriniz. Sekildeki DOS
ekranina benzer bir gdrintl belirecektir.

C:\Program Files\Computers and Structures\ETABS ServeriLicense Managerilsdecode.exe

SentinellM 7.2.8 License Decoding Utility
Copyright (C» 2882 Rainbow Technologies,. Inc.

Reading license codes from file: "C:sProgram Filesz“Computers and Structures~ETAB
% ServertLicense Manager:lzeruvrc'

License code: "092UZIZDUMB?LES6CIFEAASQS7MEIBQANZLTI627PCB6AGRGUECIBUIDH “EtabhML'"
version 8", expires Midnight of Aug 31, 2805, additive"

Normal Metwork
TEtabHL™
Ilsll

1

Inlimited._

Morning of Aug 11, 2863
Midnight of Aug 31, 28685
Primary = “"2@AaB3"

Sentinel Computer ID

License Type
Feature name
Feature version

Max concurrent users
foft limit on uzsemws
Licensze start date
Expiration date
Server locking code
Lock code depends on

Additive license Ynumber of tokens will be added>.
GClient host name based sharing.

Additivesexclusive

Sharing criterion

Sharing limit

Held licenses

Token lifetime C(heartbheatl
Action on clock tamper

3

Allowed, hold time set by license.
188 zecs <3 mind<s))

Mo action.

YES
i

Commuter License Allowed
Log Encruyption Level

Prezs Enter to continue .

(License Type : Normal Network) olarak gdrinmelidir. (Trial Network) olarak
gérintiyorsa program kurulmamis ve siz hala 30 ginlik lisans stresini
kullaniyorsunuz demektir. Bu durumda baser@comp-engineering.com veya Tel: 0049
6406 73667 ye bildiriniz.

Ek olarak, (Server locking code) ni not ediniz ve (Lock code depends on) un
karsisinda (Sentinel Computer ID) yazdigini kontrol ediniz. Bu sayi, yukarida
WechoID.exe programi ile buldujumuz sayilya esit olmalidir.

Eder bu degerler farkli ise e-mail ile (baser@comp-engineering.com) e bildiriniz.
Bu mail’de (lsdecode.exe) ve (WechoID.exe) sonuc¢larinin ekranlarinin kopyalanmis
grafik dosyalarini da birlikte gbnderiniz.

Bu dederler ayni olmasina karsin lisanslar WImAdmin.exe penceresinde yine de dodru
gbsterilmiyorsa, lisansi dogru kurmamissiniz veya dodru galismiyor demektir. Bu
durumda su islemlerle devam ediniz:

i) (Program Files/Computers and Structures/CSI Program Server (Ornedin-
SAP2000 9 Server)/License Manager/ lsLicense.bat) 1 ¢ift tiklayiniz. Bu,
lisans dosyasini License Server’' e kaydedecektir. EJer (Error 93) hatasi
alirsaniz bunu birden fazla uyguladiniz ve lisans halihazirda kayda gecmis
demektir. WImAdmin.exe penceresinden lisansi tekrar kontrol
edebilirsiniz.
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ii)

Lisans yine de kayda ge¢memisse, lisans zamani gegmis veya halen deneme
(Trial License) dbneminde bulunmaktasiniz. Su hata mesajlari gdrlinebilir:

SentinelIM: Error([17] Probably no servers running on this subnet;
SentinelIM: Error[19] Failed to add License

Bu durumda lisans eklemek icin WImAdmin.exe cift tiklayarak (Subnet
Servers) klasérinl tiklayarak aciniz (genisletiniz) ve (server) ismini
aciniz. Dedistirmek istedidiniz Lisansi sec¢iniz. Lisansi sag tiklama ile
Se¢/Sil (Select/Remove) &zelligini kullanarak (Trial License) ve zamani
gecmis lisansi elimine ediniz.

Simdi (Server) ismini sag tiklayiniz;

(Add feature > From a File > To Server and its File) komutlarini
uygulayarak dosya penceresinde beliren lisans lservrc dosyasini tiklayarak
acin. Simdi lisans gorlnecektir. WImAdmin penceresini glincelleyebilirsiniz
(refresh) . Simdi gbsterilen lisans tUrlnin (Normal License) oldugunu teyid
ediniz. Simdi A§’daki herhangi bir bilgisayardan (Client Workstation)
lisans alabilmelisiniz. Bu tip problemleri ¢dzmek icin DOrdimcli Adim daki
agiklamalara: okuyun.
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Dordincii Adim:
Herhangi bir (Client Workstation), (License Server) den lisans alabiliyor mu?

SentinellM License Server, korunmus yazilimlarin cok kullanicili ortamlardaki
kullanici ve bilgisayarlari dizenleyen bir programdir. Bu program normalde AJ
lizerindeki herhangi bir yazilimin bulundudu klasére yerlestirilir. Yazilimi
herhangibir bilgisayardan g¢alistirana Misteri (client) denir. Bu bilgisayar ise
Misteri bilgisayari (Client workstation) olarak adlandirilir. Korunmus bir yazilim
Client’'te galistirilirsa, program AJ Uzerinden (License Server)’den lisans
(password) sorar ve g¢alismak igin izin ister. (Licemse Server) ise uygunsa bu izni
ayn1 yoldan gdnderir.

Farkli alt server’lerdeki (Subnet Server) Client’ler de Sistem Cevre Degiskeni
(System Enviromment Variable) olarak LSFORCEHOST'u tanimlayarak lisans alabilirler.
Su islemler gerekir:

WlmAdmin.exe programini c¢alistirin ve IP Adresini (IP Address) ve Server ismini
(Server Name) not alin.

LSFORCEHOST parametresini su sekilde uygulayin:
Windows 2000 ve Windows XP kullaniyorsaniz; (Start > Control Panel > System >

Advanced) kutusuna gidin ve (Environment Variables) da (New) kutusunu tiklayin ve
su bilgileri girin:

Variable = LSFORCEHOST
Variable Value = License Server bilgisayarinizin IP Adresi (Yukarida kaydetmis
oldugunuz)

Windows NT kullaniyorsaniz; (Start > Control Panel > System > Environment) kutusunu
tiklayin ve su bilgileri girin:

Variable
Value

LSFORCEHOST
License Server bilgisayarinizin IP Adresi (Yukarida kaydetmis oldugunuz)

E§er sizin AgJ’iniz dinamik IP adresi kullaniyorsa IP Adresi yerine SERVER ismini
kullanmaniz gerektigini hatirlatalim.

Ayrica (C:/Windows/System32/Drivers/ETC) klasdrini ag¢ip dosya sonuna su dederleri
iceren satiri ekleyin:

IP Adresi ServerIsmi
Ornedin:
132.56.0.130 ENGSERV

Bu dosyayi kaydedin ve bilgisayari kapatip ac¢in. Bodylece (Client Workstation)
problemleri ¢ozilmis olmalidir.

Problemler devam ederse ise e-mail ile (baser@comp-engineering.com) e bildiriniz.
Bu mail’de (lsdecode.exe), (WechoID.exe) ve WImAdmin.exe sonu¢larinin ekranlarinin
kopyalanmis grafik dosyalarini da birlikte gdnderiniz.
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Lisans Kontrolu ve Kurma Problemlerinin Cozumi -
Koruma Kilit’siz ve Ag’da Kullanildiginda Problemlerin Cozimi
(License Trouble Shooting Guide - Network - Disc ID.doc)

Once su konulari asadida gdsterildigi gibi kontrol ediniz:
Birinci Adim: (SentinellM License Server) programi kurulmus ve g¢alisiyor

olmalidir

Ikinci Adim: SERVER (License Server) CSI yazilim lisansini (License Code)
tanimalidir

Uclincii Adim: Workstation’lar lisans kodunu (password) SERVER'den
alabilmelidir.

Birinci Adim -
(SentinellM License Server) programi kurulmus ve galisiyor olmalidir

Kurulmus mu?

SentinellM programi kurulmus ise (Control Panel) de (Add/Remove Programs) da
program ile ilgili bir kayit bulunmalidir. Yok ise bu doklmandaki A§’da (Network)
Kurulumu bdlimine veya programla gelen CD ROM daki Sap Install Instructions.pdf ye
bakiniz.

Calisiyor mu?

SentinellM programi normalde otomatik olarak calisir. (Control Panel) > (Services)
Burada SentinellM kaydinin bulunduduna emin olun. Bulduktan sonra durum’a (status)
bakip ¢alismakta oldufuna emin olun (started). EJer galismiyorsa sag tiklayarak
(start) ile galistiriniz.

SERVER ile iletisim tamam m1?
(Program Files/Computers and Structures/SAP2000 9 Server/WImAdmin.exe) programini
¢ift tiklayarak calistiriniz.

Eder ‘SentinellM: Error[17] Probably no servers running on this subnet’ mesajini
alirsaniz sizin Firewall’iniz iletisimi engelliyor olabilir. SERVER ve CLIENT
arasinda iletisimin olabilmesi ig¢in UDP port 5093 ag¢ik olmalidir. Bunun ig¢in teshis
programi olan UDPTester su adresten indirilebilir:

ftp://ftp.csiberkeley. com/pubdocs/KeyDriver/
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Ikinci Adaim:
SERVER (License Server) CSI yazilim lisansini (License Code) tanimalidir

Istemis oldujunuz sabit lisans sadece bu A§’da calisir ve difer Ag’larda calismaz.

(Program Files/Computers and Structures/SAP2000 9 Server/WImAdmin.exe) programini
¢ift tiklayarak c¢alistiriniz.

(Subnet Servers) ve (Server) klasdrlerini tiklayarak aginiz (genisletiniz) .
Programinizin lisansini burada gdreceksiniz.

m WimAdmin

File Edit Wew Help
28 Defined Servers ~
‘E‘ Server information
% igbalzkl. csi-ad. computersandstructures Server name: IEk'I.-:Si-ad.computersandstructur- IP address: 10.0.0103
+ @ igbalxplap.csi-ad, computer sandstruckur
L marilyn2k1.csi-ad.computersandstruct@l
+ [ 108 Feature infarmation
Feature name: | EtabML ‘Wergion: a
+-{"] ErabhLC & Statishics
[ EtatpL & In use: Total: Queued:
+ [ 5afe 7 Total uzers: HEEE 2 10 0
+- [ safeplL & FReserved: 0 0
+ [ sara
+ [ sapaD & Commuter: 0 g
+-] sapPer 8
+-7] saPHT &
. E SAPML 8 Redundant: | Mo Mumber of servers: 1
+1-[F] sapos s
+ [ sapPL & Detailed information
« [ sea : ;
Licenze Info
+)- (@) MARILYNNTZ | Clent o |
[ License type: Nomal Iicense] tart date: | Mon Sep 09 00:00:00 2002
e e o Yes End date: | Thu Sep 30 23:55:59 2004
Criteria | Yalue | ”~
Log encryption level 1
b ajority ule Mo
Mumber of subhets 0
Eerver #1 locking eode.. 4237700
Sharing critena Uszername 1D
Sharing limnit 10
Soft limit Unilimited |
Stand-glone license Mo “
{- } = e
Ready MLIM

Lisans orada ise daha da agarak ‘Lisans Tipi’ ne bakiniz. Burada ‘Trial License’
dedil ‘Normal License’ yazmalidir. Ayrica lisansin gegerlilik tarihini kontrol
ediniz.

Burada dodru veriler gdrinse bile size gdnderilen lisans dosyasi bozuk ise veya
herhangi bir nedenle bozulmussa lisans islemi tamamlanmis olmayabilir. Bu nedenle
su islemle kontrola devam edilmelidir:
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(Program Files/Computers and Structures/CSI Program Server (Ornedin- SAP2000 9
Server) /License Manager/ lsdecode.exe) yazilimini calistiriniz. Sekildeki DOS
ekranina benzer bir gdrintl belirecektir. Bu pencere gdrinmezse size gdnderilen
lisansin (Zip’ini) tekrar acip yukaridaki klasdre kopyalayiniz ve islemi
tekrarlayiniz. Sekildeki DOS ekranina benzer bir gdrintl belirecektir.

C:\Program FilesWComputers and Structures\SAP 2000 Server\l icense Managerilsdeco

SentinellLM 7.2_.8 License Decoding Utility
Copyright (C)> 2082 Rainbow Technologies, Inc.

Reading licenze codes from file: “C:“Program Files“Computers and Structures“SAP2
HAA Server-License Managerslserurc'

License code: “BIB?ZZMOJTNOUOSDY?ISFBFL3ZMZ8P36CWYNIESHAJPURSH?LPIDMZ# “"SAPHNL™ v
ersion 8", expires Midnight of Jan 31, 2805, additive"

MHormal Metwork
"SAPHL™
llsll

i

Unlimitad,

Morning of Feh 21, 2863
Midnight of Jan 31. 28@A5
Primary = "24A96""

Dizsk ID in hexadecimal

License Type
Feature name
Feature version

Max concurrent useps
Soft limit on usawps
License start date
Expiration date
Server locking code
Lock code depends on

Additive license {numbher of tokens will he added>.
Client host name bhaszed szsharing.

Additivesexclusive

Sharing criterion

Sharing limit

Held licenses

Token lifetime C(heartheat2
Action on clock tamper

[

Allowed. hold time set by license.
188 =zecs (3 mind{s>>

Mo action.

YES
1

Commuter Licensze Allowed
Log Encryption Lewvel

Press Enter to continue .

(License Type : Normal Network) olarak gdrimmelidir. (Trial Network) olarak
gorintiyorsa baser@comp-engineering.com veya Tel: 0049 6406 73667 ye bildiriniz ve
yenisini isteyiniz.

Devam ederek (Server locking code)unu not ediniz ve (Lock code depends on) un
karsisinda (Disc ID in Hexadecimal) yazdigini kontrol ediniz. Bu sayi (Server
Locking code), ilerideki (Disk ID Locking Code) a esit olmalidir.

Bilgisayarinizin (Disc ID Locking Code) u kontrol etmek ig¢in (echoID.exe) yi

galistiriniz. Not: Bu programi SERVER bilgisayarinda (License Server Computer)
galistirmalisiniz. BbOylece su DOS ekrani gorintlye gelir.

SentinelLM 7.2.0 Host Locking Code Information Ukility B4 |

Locking Code 1@ 4-23770

Bu say1l daima (4) ile baslar ve arkasindan gelen 5 haneli sayi Lsdecode ekranindaki
saylya esit olmalidir. EJer bu dederler farkli ise e-mail ile (baser@comp-
engineering.com) e bildiriniz. Bu mail’de (lsdecode.exe) ve (echolD.exe)
sonuglarinin ekranlarinin kopyalanmis grafik dosyalarini da birlikte gdnderiniz.
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Bu dederler ayni olmasina karsin lisanslar WImAdmin.exe penceresinde yine de dodru
gorinmiyorsa, lisansi dodru kurmamissiniz veya dodru c¢alismiyor demektir. Bu
durumda su islemlerle devam ediniz:

i)

ii)

(Program Files/Computers and Structures/CSI Program Server (Ormedin-
SAP2000 9 Server)/License Manager/ lsLicense.bat) 1 c¢ift tiklayiniz. Bu,
lisans dosyasini License Server’' e kaydedecektir. Eger (Error 93) hatasi
alirsaniz bunu birden fazla uyguladiniz ve lisans halihazirda kayda gecmis
demektir. WImAdmin.exe penceresinden lisansi tekrar kontrol
edebilirsiniz.

Lisans yine de kayda gecmemisse, lisans zamani gegmis veya halen deneme
(Trial License) ddéneminde bulunmaktasiniz. Su hata mesajlari gdrlinebilir:

SentinelIM: Error([17] Probably no servers running on this subnet;
SentinelIM: Error[19] Failed to add License

Bu durumda lisans eklemek icin WImAdmin.exe cift tiklayarak (Subnet
Servers) klasérini tiklayarak aciniz (genisletiniz) ve (server) ismini
aginiz. DeJistirmek istediginiz Lisansi seginiz. Lisansi sag tiklama ile
Se¢/Sil (Select/Remove) &zelligini kullanarak (Trial License) ve zamani
gecmis lisansi elimine ediniz.

Simdi (Server) ismini sag tiklayiniz;

(Add feature > From a File > To Server and its File) komutlarini
uygulayarak dosya penceresinde beliren lisans lservrc dosyasini tiklayarak
acin. Simdi lisans gorlnecektir. WImAdmin penceresini glincelleyebilirsiniz
(refresh) . Simdi gbsterilen lisans tUrlnin (Normal License) oldugunu teyid
ediniz. Simdi A§’daki herhangi bir bilgisayardan (Client Workstation)
lisans alabilmelisiniz. Bu tip problemleri cdzmek igin ﬁgﬁncﬁ Adim daki
agiklamalara: okuyun.
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Uclincii Adam:
Herhangi bir (Client Workstation), (License Server) den lisans alabiliyor mu?

SentinellM License Server, korunmus yazilimlarin cok kullanicili ortamlardaki
kullanici ve bilgisayarlari dizenleyen bir programdir. Bu program normalde AJ
lizerindeki herhangi bir yazilimin bulundudu klasére yerlestirilir. Yazilimi
herhangibir bilgisayardan g¢alistirana Misteri (client) denir. Bu bilgisayar ise
Misteri bilgisayari (Client workstation) olarak adlandirilir. Korunmus bir yazilim
Client’'te galistirilirsa, program AJ Uzerinden (License Server)’den lisans
(password) sorar ve g¢alismak igin izin ister. (Licemse Server) ise uygunsa bu izni
ayn1 yoldan gdnderir.

Farkli alt server’lerdeki (Subnet Server) Client’ler de Sistem Cevre Degiskeni
(System Enviromment Variable) olarak LSFORCEHOST'u tanimlayarak lisans alabilirler.
Su islemler gerekir:

WlmAdmin.exe programini calistirin ve IP Adresini (IP Address) ve Server Ismi’ni
(Server Name) not alin.

LSFORCEHOST parametresini su sekilde uygulayin:
Windows 2000 ve Windows XP kullaniyorsaniz; (Start > Control Panel > System >

Advanced) kutusuna gidin ve (Environment Variables) da (New) kutusunu tiklayin ve
su bilgileri girin:

Variable = LSFORCEHOST
Variable Value = License Server bilgisayarinizin IP Adresi (Yukarida kaydetmis
oldugunuz)

Windows NT kullaniyorsaniz; (Start > Control Panel > System > Environment) kutusunu
tiklayin ve su bilgileri girin:

Variable
Value

LSFORCEHOST
License Server bilgisayarinizin IP Adresi (Yukarida kaydetmis oldugunuz)

Eger sizin AgJ’iniz dinamik IP adresi kullaniyorsa IP Adresi yerine SERVER ismini
kullanmaniz gerektigini hatirlatalim.

Ayrica (C:/Windows/System32/Drivers/ETC) klasdrini ag¢ip dosya sonuna su dederleri
iceren satiri ekleyin:

IP Adresi ServerIsmi
Ornedin:
132.56.0.131 ENGSERV

Bu dosyayi kaydedin ve bilgisayari kapatip ac¢in. BoOylece (Client Workstation)
problemleri ¢ozilmis olmalidir.

Problemler devam ederse ise e-mail ile (baser@comp-engineering.com) e bildiriniz.
Bu mail’de (lsdecode.exe), (WechoID.exe) ve WImAdmin.exe sonu¢larinin ekranlarinin
kopyalanmis grafik dosyalarini da birlikte gdnderiniz.
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cowwrer  TEL 0049 6406 73667 '
- [Fax 0049 6406 4745 COMPUTERS &
e-mail | baser@comp-engineering.com ENGINEERING

Request for License

In order to generate a permanent license file, the following
information is required. Please read the choices carefully.

A fee will be charged if the license needs to be changed.

Fax or email this completed form to CSI/Computers & Engineering.
Your license file will be returned by email.

Customer Information

Company Name: Location:

Contact Name: Phone:

Adress: Fax:

Country: TURKEY City: Zip (Postal Code) :
Email :

Reseller (Dealer): COMPUTERS & ENGINEERING |Date:

You have the option of choosing a Standalone or Network License.

With a Standalone license the software will only work on a single computer locally.
The license file for the Standalone installation can be linked to a specific computer or to a
Computer ID Key. If you use a Key, you can move it and the corresponding license file from
your work computer to your home computer or laptop. If you did not receive a Computer ID
Key with your order, you may request one. Please refer to the Installation Instruction
Card to determine the Locking Code for a Standalone Installation if you do not have a
Computer ID Key.

With a Network License the software will work on a local area network, even if you
have a single license. Also, you have the option of ‘checking out’ a license from the
License Manager Server to a laptop by using the ‘commuter’ utilities WCommute and
WRCommute. The license file for the Network installation can be linked to a specific server
or to a Computer ID Key.

If you did not receive a Computer ID Key with your order you may request one. Please
refer to the Installation Instruction Card to determine the Locking Code for a Network
Installation if you do not have a Computer ID Key.

r1s. Chooseone: O License file for Standalone Installation O License file for Network Installation

Choose one of the following to lock the

License file to: # Licenses # Add-on Licenses
O Lock to Computer (No Computer ID key) ETABS Plus v8
See Program Installation Instructions ETABS Nonlinear v8

to determine the following:

Locking Code SAFE v7

SAP2000 Std./Basicv8
SAP2000 Plus v8
SAP2000 Nonlinear v8

SAP2000 Offshore

O New Computer ID Key SAP2000 Bridge

Key will be shipped to you
O Existing Computer ID Key (Hardlock)

I already have a Key, SAP2000 Advanced v9
Serial Number (4 digit Alphanumeric) Section Builder v8
CsicoL

Note: Please use a separate form for each camputer or each key.

Select Application(s) and/or Add-on(s) needing a license file:

SAP2000 Staged Constr
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Sikca Sorulan Sorular — Destek Cevaplan

Soru:
Programlar Ag’da g¢ok yavas galisiyor !?

Ozim:
Su islemleri uygulayiniz:
1- C:/Windows veya C:/WinNT klasoérime gidiniz ve (.TB2) uzantili tim dosyalari
siliniz.
2- Program SERVER’inin IP adresini ve Server Ismi’ni kaydediniz

2a) LSFORCEHOST parametresini su sekilde ayarlayiniz:
Windows NT, 2000 ve XP ig¢in (Control Panel > Systems > Advanced tab >
Enviromment Variable > System Variable) 1 aginmiz ve su bilgileri isleyiniz:

Enviromment variable = LSFORCEHOST
Enviromment value = (Program Server’inizin IP adresini buraya yaziniz)

Bu dosyay1 kaydediniz (save) ve bilgisayarinizi (workstation) kapatip
aginiz (Boot) .
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SORU 1:

We have one license of SAP2000 v8 standard. Upto now we were using this version as
standalone but we were carrying the dongle from one computer to another very often. We
decided to get a network license and requested new license..

But we couldn't setup the program although we have read all the trouble shootings and
install instructions...

our new lsevrc file is:

K59RN25VDDJI 70VAXJ4VIJMA6 IXCMYANUKH8EQSVVUKSFE8Z2Q0# "SAP" version "8",
expires Midnight of Aug 31, 2007, additive

Using the installation cdrom I install SAP2000 v8 standard server. After installation
finishes

I install F:\License Manager\Server\Setup\setup.exe as defined in the installation
instructions.

but after this installation my computer slows down and if I look at the task manager I see
that

lservnt.exe occupies the whole cpu (99%). And if I don't force to finish this application
my computer hangs.

here is what we did to set up new license and what we get as outputs:

1sdecode output:

SentinelIM 7.2.0 License Decoding Utility
Copyright (C) 2002 Rainbow Technologies, Inc.

Reading license codes from file: "C:\Program Files\Computers and Structures\SAP2
000 8 Standard Server\License Manager\lservrc"

License code: "K59RN25VDDJI70VAXJ4VIIMAGIXCMYANUKHSEQSVVUKSFESZ2Q0# "SAP" versio
n "8", expires Midnight of Aug 31, 2007, additive"

License Type : Normal Network

Feature name : "SAP"

Feature version ;g

Max concurrent users ¢ 1

Soft limit on users : Unlimited.

License start date : Morning of Aug 31, 2005
Expiration date : Midnight of Aug 31, 2007

Server locking code : Primary = "28582"

Lock code depends on : Sentinel Computer ID
Additive/exclusive : Additive license (number of tokens will be added) .
Sharing criterion : Client host name based sharing.
Sharing limit : 3

Held licenses : Allowed, hold time set by license.
Token lifetime (heartbeat): 180 secs (3 min(s))

Action on clock tamper : No action.

Comuter License Allowed : YES
Log Encryption Level : 1

Press Enter to continue .

wechoid.exe output: (with only computer id checkmark)

computer id : C4AG697AA
code: 0x28582

1slicense.bat output:
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C:\Program Files\Computers and Structures\SAP2000 8 Standard Server\License Mana
ger>lslic -F lservrc

SentinelIM 7.2.0 License Addition/Deletion Utility
Copyright (C) 2002 Rainbow Technologies, Inc.

SentinelIM: Error[17]: Probably no servers are running on this subnet.

SentinelIM: Error[4]: License server hostname not specified correctly. Set envir
onment variable LSHOST to (colon-separated) name(s) of server(s).

Press Enter to continue .

initially:
[-]1 Defined servers
--no servers
[+] subnet servers

after I double click on the subnet servers, a dialogbox appears:

information: SentinelIM: Error[17]: Probably no servers are running on this subnet. [OK]
Wlmadmin: The system cannot retrieve the servers, there is no response to the
broadcast . [OK]

I am using Windows XP home edition with AMD Athlon XP 1800+ and 256mb RAM...
I was perfectly using the SAP2000 v8 standalone version with this configuration.
How can I use SAP2000 again with this license...

CEVAP 1:

Firstly, Windows XP Home Edition is not recommended for network licensing. Please see the
following for error codes 17 & 4.

Have you installed the License Manager Server software? Error [17] usually
indicates that this software is not running.

By installation default this program would have been installed in:
C:\Program Files\Rainbow Technologies\SentinellM 7.2.X.X Server\English

If you did install it check whether the service is running, i.e., go to
Start > Settings > Control Panel and locate Services (where it is depends on
your operating system, for Windows 2000 it's in Administrative Tools). There
should be an entry for SentinellM and it should say started. If it's there
but not started then you need to log on with full administrative rights and
start it.

If you did install the software, run WlmAdmin.exe. (This file is located in
the SAP2000 8 Server\License Manager directory.) Expand Subnet Servers. If
the License Manager server is running, you will be able to see your server
Host name under Subnet Servers.

If the server name does show then, instead of running LsLicense.bat, just
copy the license into the C:\Program Files\Rainbow Technologies\SentinellLM
7.2.X.X Server\English directory. Run loadls.exe to register the license
(first select remove, then select add). If loadls.exe is not in this
directory, then the SentinellM server software is not properly installed.
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Error [4] is caused by Error [17]. You do not always have to set the LSHOST
variable. If you think you still need to set it after following the above
instructions, please refer to the SentinellM System Administrator’s Guide,
Appendix A. (SLM71sys.pdf located in the directory referenced above.)

I hope this resolves your problem.

SORU 2:

I've read your instructions.I've found a windows xp proffessional machine and installed the
sap2000 server

after installation in services I can see the SentinellM as started. (This is OK)

but inspite of this I can not run the wlmadmin...

please have a lock at the screenshots from my computer

(We have installed 3 computers but non of them worked.)

our SAP2000 version is 8.1.2: is it the problem of our version??

Best Regards

CEVAP 2:

I also suspect that you have Service Pack 2. If so, do the following to allow
communication through the XP SP2 default firewall:

Y

Click start, click Run, type wscui.cpl in the Open box, and then click OK.

Click Windows Firewall.

3. In the Windows Firewall dialog box, click the Exceptions tab, and then click Add
Program.

4. In the Add a Program dialog box, either select the program from the list that

N

appears, or click Browse to locate your program. (For the server computer select
SentinelIM & SAP2000)
5. After you select your program, click OK.

On the Exceptions tab, meke sure that the check box next to your program is selected, and
then click OK.

This will resolve the WImAdmin issue

TESEKKUR :
We have solved the problem selecting lservnt.exe and sap2000.exe as exceptions in windows

firewall settings, using your explanation.
Thank you for your support.



